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Document Conventions

There are several conventions that are used throughout this document to indicate actions to be taken or to 
highlight important information.  The conventions are as follows:

Item
 

Meaning

View Perimeter a command name or a file that you are to select

Tools > Options a command path that you are to select – usually from the pull-down 
menus

Document Name the name of a document that is not hyperlinked

Emphasis style used when referring to important word or phrases

Hyperlink style used when you have a direct link to another document on the web

Key in entering data with the keyboard

Quote style used to indicate an external source quotation

Note: text information about a command or process that you should pay 
particular attention to

1. Numbered Steps actions that you are to perform as part of the lab activities

<D> or Data press the data button on the mouse

<R> or Reset press the reset button on the mouse

<T> or Tentative press the tentative button on the mouse
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Chapter 1 - MicroStation Environment

CDOT’s MicroStation V8i SS2 workspace, V05.00.00, will look considerable different then the previous 
workspace version for XM. Most of the changes in CDOT’s workspace have been focused on utilizing out of 
the box functionality with MicroStation.  CDOT’s customizations have been rebuilt to work within the new 
interface tools and dialog boxes.

CDOT Workspace (V05.00.00)

CDOT’s workspace V05.00.00 is certified for Bentley's V8i suite of products on the following 
versions:

 MicroStation 08.11.07.443

 InRoads 08.11.07.428

Workspace V05.00.00 is certified for the following Windows Operating Systems (OS):

 Windows Vista 32-bit

 Windows 7 32-bit

 Windows 7 64-bit

The workspace root directory has been changed to Workspace-CDOT_V8i. Distribution of 
the workspace is recommended to be local to the user machine at C:\Workspace\.

The project template has changed to accommodate aerial photos.  The following folder has 
been added to store aerials:

\Project Template\ROW_Survey\Drawings\Reference_Files\Aerials

The folder location has been configured in the Project Configuration Files (PCF) as a search 
location for rasters images.



Page 8 Colorado Department of Transportation

Chapter 1 - MicroStation Environment MicroStation XM to V8i Upgrade Guide

MicroStation Interface

The MicroStation interface has changed to speed up how users work in MicroStation. The main 
tool palette that is typically docked on the left has been replaced by the new Tasks dialog box. 
The Tasks dialog box is talked about later in this chapter.  Items that have been added are 
features like; quick docking, pinning dialogs, View Toolbox location, and additional pull down 
menus.

Video:

Please take a few minutes to watch this video on how these new features work.

  MicroStation Interface

Tasks Toolbox

In the XM workspace, quickly accessing commands required numerous tool palettes to be 
either docked, move to a secondary screen, or create custom tool palettes. A new feature in V8i 
introduces the Tasks dialog box.  Tasks generally are a specific set of workflows, processes, or 
tool based commands.

http://www.coloradodot.info/business/designsupport/cadd/cdot-xm-to-v8i-training-guide-videos/microstationinterface.wmv
http://www.coloradodot.info/business/designsupport/cadd/cdot-xm-to-v8i-training-guide-videos/microstationinterface.wmv
http://www.coloradodot.info/business/designsupport/cadd/cdot-xm-to-v8i-training-guide-videos/microstationinterface.wmv


Colorado Department of Transportation   Page 9

MicroStation XM to V8i Upgrade Guide Chapter 1 - MicroStation Environment

Video:

Please take a few minutes to watch this video that works through the new Tasks dialog box 
and it’s features.

 Task Toolbox

User Customization (Standards-Local)

The CDOT V8i workspace uses more out of the box functionality making user customization 
much easier.

Function Keys

The use of Function Keys provides quick access to MicroStation commands that are assigned 
to the keyboard.  Customizing these keys enables the user to increase their productivity through 
these quick keys.  Function Keys are customized by the user and saved for that user.

1. In any dgn file, Choose Workspace > Function Keys...

p

http://www.coloradodot.info/business/designsupport/cadd/cdot-xm-to-v8i-training-guide-videos/tasktoolbox.wmv
http://www.coloradodot.info/business/designsupport/cadd/cdot-xm-to-v8i-training-guide-videos/tasktoolbox.wmv
http://www.coloradodot.info/business/designsupport/cadd/cdot-xm-to-v8i-training-guide-videos/tasktoolbox.wmv
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2. Left click on F3, making this key active to edit

3. Highlight and delete the text in the Action: field
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4. In the Action: field type in dialog openfile

Note: This key will open the File Open Dialog box.

5. Click OK

6. On the keyboard, press F3

Video:

Please take a few minutes to watch this video on how to customize the MicroStation 
interface to help streamline your workflows in MicroStation V8i.

 User Customization

http://www.coloradodot.info/business/designsupport/cadd/cdot-xm-to-v8i-training-guide-videos/usercustomization.wmv
http://www.coloradodot.info/business/designsupport/cadd/cdot-xm-to-v8i-training-guide-videos/usercustomization.wmv
http://www.coloradodot.info/business/designsupport/cadd/cdot-xm-to-v8i-training-guide-videos/usercustomization.wmv
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Attributes Tool Box

The Attributes tool box is docked above the application screen and contains the level filter, 
active level and level symbology preview.

In V8i, the active level pull down size could be defined to a specific width.  The width defined 
was set to a value that would display most levels without truncating the level name, but didn’t 
require the docked toolbox’s to continue on a second line in MicroStation.

Status Bar

The status bar has been enhanced to allow the users to control what messages to report.

1. Right click the status bar to open the options to toggle on or off

2. Select the options to turn the notification on or off.  The check mark means notification for 
that item is on.
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Depth Lock to ACS Plane

The depth lock has been replaced by the ACS Plane.  In doing so, the Auxiliary Coordinate 
Systems can now be assigned to individual views in the dgn file.

Video:

Please take a few minutes to watch this video on how to work with the new ACS locks that 
replaced the depth lock.

 ACS-Plane

http://www.coloradodot.info/business/designsupport/cadd/cdot-xm-to-v8i-training-guide-videos/acs-plane.wmv
http://www.coloradodot.info/business/designsupport/cadd/cdot-xm-to-v8i-training-guide-videos/acs-plane.wmv
http://www.coloradodot.info/business/designsupport/cadd/cdot-xm-to-v8i-training-guide-videos/acs-plane.wmv
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Chapter 2 - Viewing Your File

Several changes have been made to the way you view your dgn files in V8i SS2.  New preference settings have 
been added to control how your data is viewed globally.  Toolbars have been modified to include new tools.

User Preferences

The User Preferences can be accessed by clicking on Workspace > Preferences.  These setting 
allow the user to change some of the MicroStation functionality to better suit the users 
workflows.  In addition to functionality, some of these settings will change the way elements 
are viewed in MicroStation

Video:

Please take a few minutes to watch this video on how to adjust the most common setting in 
the User Preferences.

 Workspace Preferences

Saved Views

Saved Views are not new in V8i SS2, but what is new is how much easier is it to access them.  
The most visible location is in the Primary Tools toolbox that is docked above the application 
screen.

A Saved View toolbox has also been added that can be docked for quick access to the Saved 
View tools.

The main Saved Views dialog box has changed and has a few differences from the old 
workflow.

1. Setting up the view prior to creating the Saved View is still a necessary step

2. Open the Saved View dialog box by clicking on the Saved View icon

http://www.coloradodot.info/business/designsupport/cadd/cdot-xm-to-v8i-training-guide-videos/workspacepreferences.wmv
http://www.coloradodot.info/business/designsupport/cadd/cdot-xm-to-v8i-training-guide-videos/workspacepreferences.wmv
http://www.coloradodot.info/business/designsupport/cadd/cdot-xm-to-v8i-training-guide-videos/workspacepreferences.wmv
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3. When the view is all setup click on the Create Saved View icon

4. The Create Saved View dialog box has been completely changed

5. The Method: field is what will be used to capture the Saved View.  The two options are 
From View or From 2-Points.  From View is the default value.

6. The View Type field is all new.  This is a way to organize the types of Saved Views.  The 
options are as follows:

♦ Saved View (default value)

♦ Section View

♦ Elevation View

♦ Detail View

♦ Plan View

7. The Name field is the user specified name to call the Saved View.

8. The Description field is an optional field to provide additional information about the Saved 
View.

9. The Clip Volume field is set to (From View) and is recommended to not change this value 
or toggle on the Associative Clip Volume or Create Dynamic View toggles.

10. After making the changes to the settings and filling in the fields, click in the application 
view to create the Saved View.
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11. Based on the type of Saved View, different icons will be displayed to help visually 
distinguish between them.  This can also be used as a sortable field.

12. In additional to sorting,  Filters can be used to organize and view your Saved Views. Toggle 
on Filters in the Saved Views dialog box and to enable the filter fields.

View Attributes

The View Attributes dialog box has made some pretty significant changes to how you apply 
changes to views, recall saved styles and view new data formats.

Video:

Please take a few minutes to watch this video outlining the changes to the View Attributes 
dialog box.

 ViewAttributes

View Control Toolbox

The View Control toolbox has been moved to the top of the application screen as mentioned in 
the video.  The toolbox itself has been added to and some icons have changed.

Here is the old XM View Control toolbox

Here is the new View Control toolbox in V8i SS2

http://www.coloradodot.info/business/designsupport/cadd/cdot-xm-to-v8i-training-guide-videos/viewattributes.wmv
http://www.coloradodot.info/business/designsupport/cadd/cdot-xm-to-v8i-training-guide-videos/viewattributes.wmv
http://www.coloradodot.info/business/designsupport/cadd/cdot-xm-to-v8i-training-guide-videos/viewattributes.wmv
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View Attributes - Opens the dialog box to adjust the view attributes settings

View Display Mode - Opens the Display Styles dialog box that allows a display style to be set 
from a pull down list

Adjust View Brightness - Allows quick access to set scene lighting and adjustments to the 
brightness of shaded views

Update View - Redraws the view(s)

Zoom In - Increases the magnification of the view

Zoom Out - Decreases the magnification of the view

Window Area - Windows an area in a view

Fit View - Displays all viewable elements in the active dgn and attached references in the view

View Rotation - Opens the View Rotation toolbox to rotate the view
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Pan View - Allows the user to change what part of the view is displayed without modifying the 
magnification of the view

Walk - For use in a 3D file to interactively walk through a model

View Previous - Undo the last viewing operation

View Next - Redo the last undone viewing operation

Copy View - Copies the contents of one view to another

Change View Perspective - Opens the View Perspective toolbox to change the perspective 
angle of a 3d view

Clip Volume - Opens the Clip Volume toolbox to apply a clip volume to a view

Click Mask - Applies a clip mask to a view
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Additional settings can be added to the default View Control toolbox.  Right click on the View 
Control menu to toggle on those settings or toggle them off to not display.
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Chapter 3 - Selecting, Information & Measuring

Several changes have been made to the way you work with your data in the dgn files in V8i SS2.  Functionality 
with the mouse has been increased in the views, toolboxes, and dialog boxes.

Element Selection

The Element Selection dialog box has been enhanced in several ways to build upon the power 
of the current tools and workflows.  The additions and changes start with the way you select 
your elements to more advanced features such as a way to filter your data.

In XM, selecting your data entailed picking the elements one by one with the shift key, 
dragging a box around your elements, or creating a selection set with the filtering tools.  All 
these methods are still available in V8i SS2, but they have a different workflow in the selection 
process.

In V8i SS2, the way you drag your selection box to select elements is very critical.

Dragging left to right will only select the elements within the box.  The selection box will be 
solid for this selection method.

Dragging right to left will select any elements within or touching the box.  The selection box 
will be dashed for this selection method.

This is a huge productivity enhancement that typically had to be enabled through only a few 
commands in the Element Selection dialog box.
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In XM, the advanced element selection filters were limited to level, color, line style, line 
weight, element type, element class or element template.  In V8i SS2, these selection types 
have been increased to include: text style, dimension style, multi-line style, transparency, and 
display priority.

By default in V8i SS2, the new selection criteria is turned off.  To turn them on, right click on 
one of the criteria names to view the list.

Element Information

The Element Information dialog layout has not change a bit, but new functionality to interact 
with the data has been added to provide a faster process to work with your data.

When working will large selection sets reviewing the data was very difficult to find the 
elements listed in the Element Selection box in your model.  In V8i SS2, several manipulate 
and view tools have been incorporated to help the users locate the data in the model.

Right clicking on the selection items will open a selection box of commands to choose from.
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Handles

There was a toggle added to the Element Selection dialog box in XM that has presented a few 
support calls over the year.  This functionality is not new but will be discussed as a review.

If you select an element and the handles (grips) are not displaying, chances are that the toggle 
Disable Handles is on.

Located the Element Selection dialog box and verify the toggle for Diable Handles is On.

If it is on, highlighted, click it to turn it off.

The handles will immediately return and can be selected to modify the element.

Measuring

The Measure dialog box tools has made a few changes to account for the change from Depth 
lock to ACS lock.  A details drop down has been added to provide additional information on 
the measurement selections.

 

The Method pull down list was called the Distance pull down.  This list functions the same and 
a new item has been added, Maximum Between.
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The About pull down is very similar to the Mode pull down in XM.  However, the list is not the 
same.  The four items in this list are: Global Z, View Z, ACS Z, and AccuDraw Z.

Global Z — The projected distance is relative to the Global Z. Start and Finish coordinates are 
always reported as true points in the selected model relative to the Global origin.

View Z — The projected distance is relative to the View Z. Coordinates reported are from the 
Global coordinates relative to the View rotation. Start and Finish points are always projected so 
the Z value will always be 0. The Z column therefore is not displayed.

ACS Z — The projected distance is relative to the ACS Z. In 3D, Start and Finish points are 
projected from the XY plane so the Z value will always be 0. The Z column therefore is not 
displayed. Coordinates reported are about the ACS Z axis / ACS XY plane. In 3D, coordinates 
reported are projected.

AccuDraw Z — The projected distance is relative to the AccuDraw Z. Coordinates that are 
reported are the project coordinates about the AccuDraw Z axis. Since the coordinates are 
projected, the Z value will always be 0. Therefore, you will not see the Z column in the display. 
The Finish point is 0 in AccuDraw so the Start Point and Delta reports the XY components.

All four options will display the True distance taking into account the slope distance.  The 
Projected information provides the horizontal distance and will be given as well.

Additional information is available by clicking on the down arrow in the lower right.

This information is all relative to the element, not the dgn file.
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Chapter 4 - Levels

There has only been a few minor changes to the way you have to work with the Level Manager and Level 
Display dialog boxes.

Level Manager

In the Level Manager dialog box a new option was added when right clicking on a level.  The 
option is called Jump to Active Level.

This option will take you to the active level in the Level Manager dialog box.

Layouts have been added as well with the ability to store  up to 4 different layouts and easily 
recall them.  Right click on the column headers introduce this functionality.

1. Hide, show, and move the desired level columns how you see fit.
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2. Right click in any of the level column and select Save Layout > Layout 1

3. Now generate a different setup by hiding, showing, and moving the desired level columns 
how you see fit.

4. Right click in any of the level columns and select Save Layout > Layout 2
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5. When a layout is saved it is added to the right click menu.  The active layout will have a 
check mark beside it.

Note: The saved layouts are stored in the User Preference.

Level Display

The Level Display box has changed the way you apply the level view settings to the open 
views.  If only one view is open, simply click levels to turn on or off the display.  This part 
functions much like XM.  However, if multiple views are open this process is much different.

The numbered views have been replaced by a few icons.  These two icons are called, Apply to 
Open Views and Apply to Selected Views.
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The first icon, Apply to Open Views, will apply the level status to all views that are open.  The 
views that are not open will remain unchanged.

The second icon, Apply to Selected View, allows the ability to specify select views to apply the 
display changes to by clicking within the open view window.
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Chapter 5 - Models

A significant enhancement with viewing models in MicroStation V8i called Multi-Model Views.  The 
functionality of Multi-Model Views will reduce how many times the active model is changed.

Viewing Multiple Models

In the past views could only be of the active model.  In V8i, other models in the dgn file can be 
viewed and edited in the active model.  This will reduce the time switching between models  
making edits and annotating the sheet files.

Video:

Please take a few minutes to watch this video on how to view a a separate model in the 
active model.

 View Multiple Models

http://www.coloradodot.info/business/designsupport/cadd/cdot-xm-to-v8i-training-guide-videos/viewmultiplemodels.wmv
http://www.coloradodot.info/business/designsupport/cadd/cdot-xm-to-v8i-training-guide-videos/viewmultiplemodels.wmv
http://www.coloradodot.info/business/designsupport/cadd/cdot-xm-to-v8i-training-guide-videos/viewmultiplemodels.wmv
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Chapter 6 - Referencing

Working with reference files has made some big jumps forward.  The ability to edit references without getting 
out of the drawing is a huge time savings feature.  More functionality with scales will prove to streamline 
workflows.

Reference In-place Editing

Being able to edit attached references will prove to be a huge time savings.  Past workflows 
would require the user to use the Exchange command within the Reference Manager dialog box 
to quick switch drawings to make edits.  Changing back to the previous file is not as easy.  
Typically you would be able to use the file history to quickly open the last file or two, but the 
history will only go back so many files.

In V8i a new feature has been added to edit reference files without having to leave the sheet file 
called In-Place Editing.  When In-Place Editing is Activated, the reference file is locked to 
avoid other users editing the file at the same time and edits can be made.

1. To Activate the In-Place Editing of a reference file, right click on a reference element and 
hold to open the pop-up menu.
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2. Select Activate

Note: Activating the In-Place Editing will grey out all elements that are not within the 
reference file.  This allows for quick identification of the elements that can be 
edited.
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3. Make the edits to the reference elements

4. When finished making edits, Deactivate the In-Place Editing by right clicking on a 
reference element and select Deactivate CDOT Default.  CDOT Default is the name of the 
model.

5. This will save the file and release the lock on the file for editing by other users.
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Active Model Annotation Scale

Applying the correct settings to the annotation scale and model properties are essential to the 
development and presentation of your cadd files.

Video:

Please take a few minutes to watch this video on how to identify how existing graphics 
scale settings are applied and how annotation settings need to be set to display your 
graphics correctly.

 Annotation Scale

Detail Scale

A new pull down in the Reference Attachment Settings dialog box has been added to help 
remove calculating detail attachment scales.  The pull down uses the scales setup for the model 
properties and applies them to the Scale (Master:Ref) settings in Raster Manager.

1. Attach a detail dgn.  At the Reference Attachment Settings dialog box locate the Detail 
Scale pull down

http://www.coloradodot.info/business/designsupport/cadd/cdot-xm-to-v8i-training-guide-videos/annotationscale.wmv
http://www.coloradodot.info/business/designsupport/cadd/cdot-xm-to-v8i-training-guide-videos/annotationscale.wmv
http://www.coloradodot.info/business/designsupport/cadd/cdot-xm-to-v8i-training-guide-videos/annotationscale.wmv
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2. Click the pull down to select the correct detail scale
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3. For this detail the scale is 1/4” = 1’.  Notice that when you set the Detail Scale the Scale 
(Master:Ref) values are automatically set based on that scale.

4. Place the reference and move it into place.
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Reference File Types

Additional file types have been added to reference in MicroStation.  A list of acceptable files 
that can be referenced are listed under the Files of type: in the Attach Reference dialog box.
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Chapter 7 - Printing

The Batch Print utility in MicroStation XM has been replaced with Print Organizer and Print Styles have been 
created to insure users are assigned CDOT printing and plotting settings.

Print Organizer

Individual files and models are now stored into Print Organizer and saved into a print set file 
(.pset). Any job set (.job) files that were created with the MicroStation XM  Batch Print utility 
can be opened and converted to the new format.

Files can be added to a Print Organizer print set file simply by draging and dropping the file 
into Print Organizer. All referenced and attachment files will be stored along with the file.

Once files are stored and saved into the print set, individual files and full plan sets can be 
generated into PDF files or hard copies at the printer or plotter

Video:

Please take a few minutes to watch this video on how to use Print Organizer.

 Print Organizer

http://www.coloradodot.info/business/designsupport/cadd/cdot-xm-to-v8i-training-guide-videos/printorganizer.wmv
http://www.coloradodot.info/business/designsupport/cadd/cdot-xm-to-v8i-training-guide-videos/printorganizer.wmv
http://www.coloradodot.info/business/designsupport/cadd/cdot-xm-to-v8i-training-guide-videos/printorganizer.wmv
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1. Open Print Organizer from within MicroStation V8i by selecting File > Print Organizer.

2. Files are added to the set file by dragging and dropping from Windows Explorer or using 
the Add Files to Set icon.
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Print Styles

A Print Style is a collection of frequently used properties that have been created to enable the 
user to efficiently use saved CDOT printing and plotting settings.

When these print styles are not enough, the user can define custom print styles and save them 
for later use.

Video:

Please  watch this video on how to assign and create Print Styles.

 Print Styles

http://www.coloradodot.info/business/designsupport/cadd/cdot-xm-to-v8i-training-guide-videos/printstyles.wmv
http://www.coloradodot.info/business/designsupport/cadd/cdot-xm-to-v8i-training-guide-videos/printstyles.wmv
http://www.coloradodot.info/business/designsupport/cadd/cdot-xm-to-v8i-training-guide-videos/printstyles.wmv
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Chapter 8 - Geographic Tools

The new Geographic Tools feature in MicroStation V8i SS2 enables MicroStation project design models to be 
assigned a geographic coordinate system allowing for better integration with GIS and multiple coordinate 
systems.

Geographic Toolbar

The Geographic toolbox in MicroStation V8i SS2 is used to assign geographic coordinate 
systems to MicroStation models.

Tools are available for setting up geographic coordinate systems, interfacing with GPS devices, 
and interfacing with Google Earth.

General Workflow

The first step is to define a geographic coordinate system using the Select Geographic 
Coordinate System on the toolbox. This will open up a dialog box where coordinate systems 
can be selected from a library and assigned to the model.  Colorado coordinate systems are 
available in a seperate folder.

1. The Geographic toolbox can be opend from within MicroStation by accessing the Tools 
pulldown.

2. Selecting the Open As Toolbox will open a toolbox with all the Geographic tools.
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3. Selecting the first icon, Select Geographic Coordinate System will open the Geographic 
Coordinate System dialog box. This toolbox is used to make coordinate system 
assignments to the model.

Raster Image Coordinate Assignments

Reference files can also have a geographic coordinate system assigned.

Image assignments are made in Raster Manager. 

1. From the Utilities pulldown, select Coordinate System and Select From Library.

Video:

Please take a few minutes to watch this video on how to assign a coordinate system to a model 
and a raster.

 Geographic Tools Workflow

http://www.coloradodot.info/business/designsupport/cadd/cdot-xm-to-v8i-training-guide-videos/graphictoolsworkflow.wmv
http://www.coloradodot.info/business/designsupport/cadd/cdot-xm-to-v8i-training-guide-videos/graphictoolsworkflow.wmv
http://www.coloradodot.info/business/designsupport/cadd/cdot-xm-to-v8i-training-guide-videos/graphictoolsworkflow.wmv
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Chapter 9 - InRoads Enhancements

A number of changes have been made to the InRoads program and how InRoads works directly with 
MicroStation.  These include integration into the MicroStation Tasks dialog box, menu consolidation and 
updates, and additional functionality to the Roadway Designer.

Integration with MicroStation

InRoads has been integrated into MicroStation more than ever.   Additions include loading the 
software to executing InRoads commands from the MicroStation Tasks dialog box.

Video:

Please take a few minutes to watch this video on how InRoads works with the MicroStation 
Tasks dialog box and an overview of the major InRoads dialog boxes that have changed.

 InRoads Changes

Additional InRoads Items

Explore Show/Hide

With the better integration with MicroStation there is a toggle to be aware of.  This setting 
controls whether or not the InRoads dialog box will display.  This toggle can be found through 
the MicroStation pull down; Applications > InRoads Group > Tools > Explore Show/Hide.

http://www.coloradodot.info/business/designsupport/cadd/cdot-xm-to-v8i-training-guide-videos/inroadschanges.wmv
http://www.coloradodot.info/business/designsupport/cadd/cdot-xm-to-v8i-training-guide-videos/inroadschanges.wmv
http://www.coloradodot.info/business/designsupport/cadd/cdot-xm-to-v8i-training-guide-videos/inroadschanges.wmv
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When this setting is on, the InRoads dialog box will not display and the only way to run 
InRoads commands is through the MicroStation Tasks dialog box.

Project Options

InRoads Project Options isn’t anything new.  In fact, it is the same as the Options dialog box 
from the XM version.  The location of the Project Options has changed though.  To access the 
Project Options in InRoads click File > Project Options.
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Cross Section Consolidation

In V8i, InRoads consolidated the many Cross Section dialog boxes into one.  Select Evaluation 
> Cross Section > Cross Sections...

In the dialog box explore area are the selections for the InRoads XM commands; Create Cross 
Sections, Annotate Cross Section, Update Cross Section and End-Area Volumes.



Page 48 Colorado Department of Transportation

Chapter 9 - InRoads Enhancements MicroStation XM to V8i Upgrade Guide



MicroStation XM to V8i Upgrade Guide   Page 49

 

Index



Page 50 Colorado Department of Transportation

 MicroStation XM to V8i Upgrade Guide


	Document Conventions
	Table of Contents
	Chapter 1 - MicroStation Environment
	CDOT Workspace (V05.00.00)
	MicroStation Interface
	Video:

	Tasks Toolbox
	Video:

	User Customization (Standards-Local)
	Function Keys
	Video:

	Attributes Tool Box
	Status Bar
	Depth Lock to ACS Plane
	Video:


	Chapter 2 - Viewing Your File
	User Preferences
	Video:

	Saved Views
	View Attributes
	Video:

	View Control Toolbox

	Chapter 3 - Selecting, Information & Measuring
	Element Selection
	Element Information
	Handles
	Measuring

	Chapter 4 - Levels
	Level Manager
	Level Display

	Chapter 5 - Models
	Viewing Multiple Models
	Video:


	Chapter 6 - Referencing
	Reference In-place Editing
	Active Model Annotation Scale
	Video:

	Detail Scale
	Reference File Types

	Chapter 7 - Printing
	Print Organizer
	Video:

	Print Styles
	Video:


	Chapter 8 - Geographic Tools
	Geographic Toolbar
	General Workflow
	Raster Image Coordinate Assignments
	Video:

	Chapter 9 - InRoads Enhancements
	Integration with MicroStation
	Video:

	Additional InRoads Items
	Explore Show/Hide
	Project Options
	Cross Section Consolidation



